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PART 1.
How TonNAL WORKS



Music experience is phenomenological, but

music player is not.

Here is a simple but reliable framework to evaluate

every music player on the market:

Does it make your library uniform and clean?
How to grade its advertised “audiophile-grade”?

From where comes the music metadata?

TonAL is a rule-breaker for 2/ these questions. Read
the next page to discover how ToNAL works and to

decide if ToNAL is a good fit for you (the answer may
be no).



COLLECT
BEFORE
Pray

You can colle&t music in various lossless
formats (FLAC / WAVPACK / MONKEY’S
AUDIO / APPLE LOSSLESS / .DSF / .DFF /

.1SO / .AIFF / .WAV, etc.) into TONAL.

There’s one caveat: Red Book audio

must pass the AccurateRip verification.

Don't worry: CUETools is integrated
into Tonal to save broken rips at its
best.

You no longer need to manage your
folders, sub-folders, and files; ToNAL

manages them for you neatly.

B Tonal collects music into .tonal audio
files — a lightweight archival container
containing pure lossless PCM or DSD
data of a complete disc in standard
FLAC or WavPack encoding.

AUDIOPHILE-
(IRADE
PrayBACK

TonNaL is engineered bottom-up from a
bit-perfect engine that contains only 4
sLoc in ¢ — usually one to three orders
of magnitude less compared to

competitors.

B Tonal performs no sample-rate-
conversions. To play a release, the
selected audio device must support the
source format natively.

TonaL is absolutely configuration-free.
Playback parameters are measured and
optimized automatically before the first

note.

Music

METADATA

TonNAL audio files contain no music tag,
making it §table once created — you can

even Store them on read-only media.

Edits to music metadata are made in
the browser-based ToNAL EDITOR,
which pushes updates to the ToNAL

APP in real-time.

Collective music collection building
powered by community collaborations

on music metadata is finally possible.

The third part of the manual focuses on
music metadata editing.



LocaL-FirsT Pay-ONCE

TonaL is and will always be local-fir§t, which means: TonNAL is available from the Mac App STORE. The app is

sandboxed, which means it can not access your private data.

You don’t create any account for TONAL.

2 Download on the
You can play your collection without a network & Mac App Store

connection — audio data is stored on your
: : There is n ription fee. Buy it an n it.
internal ssD, external drive, sp card, or home ere is no subscription fee. Buy it and ow

NAS.

You can migrate or rebuild your entire library
with ToNAL SErVICES offline — music metadata

is Stored on 1CLOUD.

a Tonal Services are always required to collect music.
Tonal Editor is always required to edit music metadata.


https://apps.apple.com/us/app/tonal/id6449281141

PART 2.
THE App



ADD Music TO YOUR LIBRARY

Click the top-left [ +] button in the sidebar to collect music into TONAL by

selecting a direCtory containing one or more complete audio discs.

a Selecting a directory of fewer than 10 discs is recommended otherwise it

will take lots of time.

B Your library is located at [home]/Music/Tonal/ by default. You can

choose another location from the “Library” menu at any time.

A log file will be opened after the collection process is completed. Find more

detail there. Collected releases will be shown in your library. Labels A>Z = By Release:

© Release Years 0

A
]
<

8¢ v [T Lossless Audio Discs 8 Q

. @) Recents
fig 1. collect new music .
A Applications Name Kind Date Added
(= Desktop & :
®© Downloads 4
£5 Projects >
5 Courses
-~
Labels A= Z By Releases A Musie
© Release Years 0
& Collection Years 0 < iCloud Drive
@ Last Played Years 0 (3 Documents
il Audio Formats 0 le=) Pesktop
9 Shared Cancel m
A Artists 0
A Grou 0
PATEY ps
Composers 0
+ Conductors 0
888 Genres 0




YOUR LIBRARY

In the “Library” section, you can filter your library by:

B Clear any applied filter by clicking
the eraser button.

1.  Release Year (fig 2)

2. Collection Year f
Last Played Year fig 3. flter by audio format

4.  Audio Format (fig 3) ° + O 16-Bit 44.1 kHz

v @ DSD

B DSD 64
Release Years

@ DSD 256 T FISC
Collection Years T | prETRIC

v @ PCM
16-Bit 44.1 kHz

Last Played Years Schubert: Winterreise

Audio Formats Dietrich Fischer-Diesk

B 24-Bit 44.1kHz

fig 2. fulter by release year
B 24-Bit 48.0 kHz
Artists -
eoe & N @ 24-Bit 192.0 kHz

Ay Groups

Q, Sear 2] Composers

> 2020s
. Conductors

v [F 2010s
© Release Years Genres

2019 ,
& Collection Years 4 Estacione!

2017 Portefia (Art
" 2015 A ella Ste

il Audio Formats 1 MacBook Pro Speakers
2014
LX)

@ Last Played Years

2012

® Artists
A > ] 2000s

Add i i
4 Groups > 0 1990s Music for Film and The

Composers Hania Rani
R > (7 1980s “

Conductors ,
[ Unknown



N AVIGATE YOU R L IBRARY fig 6. browse labels and series

In the “Browse” sidebar section, you can navigate your library by:

Artist (fig. 4)

(Music) GI‘Ollp Labels A = Z By Releases
© Release Years 17
Composer (ﬁg 5) & Collection Years 1 Analogue Productions 1
Condu&or @ Last Played Years 2 Claves Records 1
Genre ﬁgﬁ' Y posem il Audio Formats 6 Decca Classical 1
Label and Series (ﬁg, 6) Deutsche Grammophon 5
4 Artists 30 v EMI Classics 4
M4 Groups 1 Great Artists of the Century 1
Composers 22 References 1
) Composers A= Z ++{ Conductors 9 Pantatone 1
ﬁ &4 browse artists © Release Years 17 5
288 Genres 8 Philips Classics 1
& Collection Years 1 Bach
{2} Labels 1 Sony Classical 1
@ Last Played Years 2 Bach
> Unitel Classica 1
il Audio Formats 6 Bach - | _ _
aacil [ MacBook Pro Speakers Victor Entertainment 1
Artists A= Z By Rele | o o Unknown 1
© Release Years 17 2 Artists =z Ralakirey
& Collection Years 1 Argerich 14 Grotp= i Barték
@ Last Played Years 2 Arroyo Compeonrs 22 Beethoven
il Audio Formats 6 Ayo =0 Conduptare 3 Berlioz
Baker 22 Genres 8 Brahms
A Artists 30 Bashmet Gt Labels 1 Chopin
M4 Groups 1 Curzon halyosy
o] 22 Dahler
lti] e [1 MacBook Pro Speakers ol
"X, Conductors 9 Demus Moszkowski
5 X [/
¥ Genres 8 Erwen Piazzolla

{2} Labels 1 Fischer-Dieskau Rachmaninoff



fig 7. output devices are listed in the

KN owW ‘audio devices” sidebar section
Your Aubpio DEVICES o 0

USB Protocol Class 2

A filled checkmark indicates the sele¢ted audio device. You can
© Release Years Asynchironious o

switch to another device by clicking the checkmark next to it. o Ciliach
ollection Years

@ Last Played Years

The symbol before an UsB device suggests its max sample rate: il Audio Formats
A Artists
. 4 Estaciones
(s ] single 1% 4t 1 /48 KkHz 14 Groups e——
5 128steps @ o
A Stei
(D) dual 2x 88.2/96 kHz SRt :
. Conductors
@ quad 4X 176.4/1 92 kHZ égé Genres
{2} Labels
(0] octa 8x 352.8/384 kHz
(X ] hexadecimal 16x 705.6/768 kHz 1 MacBook Pro Speakers
£¥ Baoshan's AirPods hiEie
48.0 kHz
7% Baoshan’s AirPods Pro
Select an audio device to inspect its tech specs in detail. Two things 88.2 kHz
might be of special interest: 96.0 kHz
LA Beethoven: P
.. . . . 192.0 kHz Nos. 4 &5
1.  USB SyncuroN1zATION MODE indicates if the device is . Curzon. Vi
running in synchronous, adaptive, or asynchronous mode. 384.0 kitz

705.6 kHz

2. Vorume ConTroL indicates the number of supported volume (R

steps. ToNAL adjusts the volume in the finest resolution when
Stereo

using the CoMMAND (38) + o/v keyboard command.




BROWSE YOUR RELEASES

Clicking a release tile in the release grid reveals the release in the detail g9 Todeletearelease:

P 1. Switch to the "[§ discs and
files” section under the
artwork.

The left column lists colle¢ted tracks of the release. Double-click a row 2. Right-click an audio file.

(or click the leading play/pause button) to tart playing from a specific 3. Select“Delete Audio File".

track, composer, work, section, or disc. A release will be removed from

your library once all its audio files
are removed.

Live at Carnegie Hall » | fig 8. release detail view
Composers A= Z By Releases Mikhail Pletnev pletnev /e’ car‘negie hall

(with sidebar collapsed)

bach-busoni - beethoven - ch i ;
Bach R T FxA ;. B : ‘

Bach Ludwig van Beethoven

Bach - Piano Sonata No. 32 in C minor, Op. 111

Bach - |. Maestoso

Balakirev .
IIl. Arietta
Bartok

Frédéric Chopin

Berlioz
Brahms Scherzo No. 1in B minor, Op. 20
Shopl Scherzo No. 2 in B flat minor, Op. 31
halyosy

Mahler Scherzo No. 3 in C sharp minor, Op. 39

The right column shows the
Moszkowski i
Scherzo No. 4 in E, Op. 54

Piazzolla artwork and release-level music

Rachmaninoff
DISC 2 )
Scarlatti 2 . ) Classical Deutsche Grammophon
Sergei Rachmaninoff R

Sch b Release Date Catalogue Number P 9 b
e Bl e B e, il crediting artists, and recording
chuber!

metadata such as genre, label,

Total Time Format >
Schumann 1:42:01 16-Bit 44.1 kHz lnfO.

A Alexander Scriabin
Scriabin

: Mikhail Pletnev, piano
Vivaldi Poémes, Op. 32 No. 1

AFSR Recording: November 2000 in Carnegie Hall, New York City, Live Cllcklng the artwork to

Domenico Scarlatti Recording

maximize it.



THaE PLAYER BAR

TonaL’s playback engine is configuration free, which means Click the artwork in the player bar will navigate the detail area
there is no settings panel and the performance is always to the playing release.

predictable. Under the hood, ToNAL performs an automatic

optimization process before playback starts and before switching A toggle mute button and a max volume button are placed on the
to a new audio format. left and right side of the volume slider.

Some icons in the player bar indicate the player is in a special Here are all the related keyboard shortcuts in the “control”

automatic transient State:

menu:
a hogging < 1 seconds Action Shortcut
X optimizing < 2 seconds Space bar Play or Pause
l:? releasing < 1 seconds Command (%) -Period Stop
Command(#¥)-Left Arrow(<«) Previous Track
When the player bar is visible, the selected audio device is Command (%) -Right Arrow(») Next Track
hogged (Or belng hogged) — no Other prOCCSS lnCludlng the .......................................................................................................................................................................................................................
. Command(3)-Up Arrow(A) Volume Up
SYSYEIML CAM USE It e
Command(#¥)-Down Arrow(V) Volume Down
Stop the playback by long-press the B or Il button, or using the Command (%) -Left Bracket([) (Navigate) Back
Command(38) + Period(.) keyboard shortcut — the selected
audio device will be released once the player is stopped. @ Volume Up/Down keyboard shortcuts adjust the volume in the

audio device's native resolution.

Hover over the track to reveal played/total/remaining time; Tonal asks “Accessibility” permission to handle

; ; . toggle max
click the progress bar to seek to a specified position. media keys (volume up/down, next/prev, etc.). mute  volume

KAER-&LSTFI v NUN—IA

ED28DERXYT v xPPP




SEARCH

The search field in the sidebar ofters a powerful global search

experience:

1.  Search for a composer to browse artists, groups,
conductors, and labels associated with the composer in the

middle column, with releases in the detail area.

2. Search for an artist, group, or conductor to browse
(collaborating) artists, groups, composers, and labels in the

middle column, with releases in the detail area.

3. Composite patterns like composer + artist, composer +

conductors, label + composers, etc. are also supported.

f1g 9. global search

P e

Q, Beethoven [ %) ADAR |

J

Conductors A > Z
© Release Years
T Collection Years Furtwangler
@ Last Played Years Knappertsbusch

it Audio Formats

A Artists
M Groups
Composers

“x. Conductors

I

[1-1]

ges Genres

1z} Labels

Beethoven

3 S Piano Concertos
s @\\(\ & “Emperor”
By Releases 2@\ = Wiener Philharmonik
CURZON
KNAPPERTS

There is also a scoped search field in the middle column to search

for a specific artist, group, composer, conductor, genre, or label.

B Clear any applied filter by clicking the eraser button.

fig 10. scoped search

- O ¢

Q. Argerich (%]

Brahms: Klavierquartett op. 25 - Schumann: Fantasiestiicke op. 88

Brahmes: Piano Quartett;
Schumann: Fantasiestiicke
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Artists A=> Z

Martha Argerich 1

By Releases

© Release Years

& Collection Years ﬂ
@ Last Played Years

il Audio Formats E
A Artists

A Groups

d| Composers
4« Conductors
8 Genres

{7} Labels




Misc FEATURES

Some features are provided for your convenience: e Composers A - Z By Releases
& Collection Years ® Bach
o @ Last Played Years B Bach
1.  The release grid has two modes: compact vs §tandard. | ,
il Audio Formats ® Bach - Busoni
Compact mode is useful for small screens. Toggle release Bach - J2:c12 Helfetz
. . . . » i Balakirev
grid mode using the View > Show Standard / Compact Grid ek .
menu command or the equivalent Control(”)-Command(38)- B Composers Beethoven
G keyboard shortcut. s Sovdicore Bertioz

é'ég Genres ® Brahms

2. Color tags can be shown or hidden when browsing artists, G} Labels . Chopin
halyosy

groups, composers, conductors, genres, or labels using the katilor

1 MacBook Pro Speakers @
Moszkowski

View > Show / Hide Color Tag menu command or the (2 Studio Display Speakers
Piazzolla
o

equivalent Control(”)-Command(88)-T keyboard shortcut.

o) Rachmaninoff

Scarlatti

Schoenberg

fig 12. color tags can be shown

> ) 20208 when browsing artists, groups,
L ah composers, conductors, genres,
= 2019

. or labels
= 2015
= 2014

@ 2012

> B 2000s ~Arabella
> [7) 1990s ; %2 Steinbacher

v110ZZVIid -

> [] 1980s
> [£] 1960s
B Unknown

fig 11. compact grid
: bides release title and
S artists

oncwestua LS

A FORTRAI OF
WAKISH JARDONE

surfin” safari



Misc FEATURES conT.

Accessibility Access (Events)

“Tonal” would like to control this computer using
accessibility features.

3. When browsing artists, composers, and conductors, you can B  Oreint sccess to this applicationin Privecy & Secirity

choose first name first or last name first, using the View > First /

Last Name First menu command or the equivalent Control(”™)-

settings, located in System Settings.

Open System Settings  ([EELE)

Command(38)-N keyboard shortcut (fig. 13). o5 o Accessibility
4. Use the Control > Enable / Disable Media Key Control menu = = =
o . (27 General - AEServer
command to enable or disable playback and volume control via (@ Appearance .
media (top row function) keys. For the firt time, you must grant (8) feceschty ;
o Control Center
“Accessibility” permission (fig. 14) in System Settings > Privacy and B
Security to let TONAL captures media key presses. TONAL supports (O Privacy & security

fine volume control using volume up/down media (top row Beskiop 8 Dock

function) keys (fig. 15) when media key control is enabled.

Composers A~ Z By Releases

lan - Busoni, F...

Berlioz, Hecto

Brahms, Jof
Chopin, Frédéric
Davis, Miles
Debussy, C
Donizetti, G
Dukas, Paul
Dvorak, Antonin
Franck

Good, Oliver

Gounod, Charles

Composers A~ Z

® & & & & o o o
Z ¢

olm Arnold

an Beethoven
120 Bellini
Berlioz
1es Brahms
Frédéric Chopin
Miles Davis
@ Debussy
Gaetano Donizetti
Paul Dukas
Antonin Dvofak
Franck
Oliver Good

Charles Gounod

@ Displays

Wallpaper

Screen Saver

fig 14. enable media key control

High on Life
By Releases
Ghosts

Crimin' & Dealin'

Hope Overture

Tense

Clint Mansell — Ghosts of Things to Come

fig 13
last name first (left) vs.

first name first (right) fig 15. fine volume control



PART 3.
EpiTiNG Music METADATA



Table of Contents

intro error checking
the editor le guide
document Structure save your edits
release block licensing

tracks block code of conduct
tracks block for classical music privacy policy

disc redirection license agreement



https://ton.al

onal offers a fir§t-class music metadata experience even though ToNnaL

audio files contain no music tag. But how?
S INTRO

A database is designed to enable collective music collection building
enhanced by community collaborations on music metadata. Although the
database is persisted in various mediums, edits are made in the browser-based

TonNaL EpITOR using TONAL METADATA LANGUAGES.

Tonal Contributors
(human beings like us)
1!

Tonal Editor
(the web app)

1 feel free to
Tonal Database

tgwore
1. Plain Text Catalog >/theja\f90""‘-
2. CloudKit Container
3.SQL Database
1!
Tonal App

I!\-{' .-@ o
bk

= S sl Sl
S{lesTioc el

bk

nif:

(the macOS app)

.1‘"‘ 3
057

f1g 1. the flow of music metadata

As the launch of the TonaAL App, edits are made on a per-disc basis.

7
7
7
7
>
FalE
<
>
=
<

el foerhel
{.4@..@..@..@..!
] S T B
<
i ke

Try to think of the database as a “card catalog cabinet” of recorded

music. fig 2.
a card catalog

More catalogs (composers, works, etc) may be introduced in the cabinet
of recorded music

next versions.



hen a release is shown in your ToNaL App, audio files associated

with the release are listed under the [§ Discs and Files se¢tion below

the artwork image.

OPEN THE EDITOR

To edit the music metadata of a disc, click the rightmos$t (4 Open in Tonal

Editor link. Your default web browser will open the editor showing the disc.

Live at Carnegie Hall
Mikhail Pletnev
DISC 1

Johann Sebastian Bach -
Ferruccio Busoni

Chaconne in D minor, BWV 1004 14:21
Ludwig van Beethoven

Piano Sonata No. 32 in C minor,
Op. 111

|. Maestoso 9:54

Il. Arietta 16:37

Frédéric Chopin

Scherzo No. 1in B minor, Op. 20 10:03

Scherzo No. 2 in B flat minor, Op. 31 10:32

pletnev |

bach-busoni - beethove

® O e o discs and files
Storage Collected
2 Files, 346 MB 5/11/2023, 2:12 AM
Audio File Audio Format Edit

1 bafbb8c82a8ad@.. 16-Bit 44.1 kHz i e——o openin tonal

. ; editor
2 8dfc73089fcéb2. 16-Bit 44.1 kHz @

f1g 3. open the editor from the Tonal app



ou need to sign in with your AppLE ID for
the firét time because all edits (by all

contributors) are auditable.

You are free to hide your email. Tonal does not send
spam emails.

The TonaL Disc METADATA EDITOR consists 3 zones:

the $tatus bar
the sidebar

the main editor

sidebar
o)

eoce [+ <

7 TRACKS DISC 0C28D20FOA98C155

I Live at Carnegie Hall
Mikhail Pletnev

il T tonal (-]
py~= e nnRmmmm——
App|e ID Cancel
T
A
A ¢
c
A Do you want to sign in to Tonal with your Apple ID
“sheng@icmd.org”?
Use a different Apple ID
J NAME Baoshan Sheng
o}
MA Share My Email
= o eng o.org
c Hide My Email
For heng
B 14

Continue with Touch ID

Wolfgang Amadeus Mozart
Violin Sonata No. 21, K. 304

T tonal & o

Classical | Deutsche Grammophon | 2001-02 | 1 / 2

RELEASE #1 ARTWORK

Johann Sebastian Bach - Ferruccio Busoni
G R e 01. Chaconne in D minor, BWV 1004

Ludwig van Beethoven

Piano Sonata No. 32 in C minor, Op. 111
09356 soe=ssssuveanadauis 02. I. Maestoso

AGABT S et s 084 IL. Arietta

ZONES

fig4.

authorize the Tonal app
for the first time

o status bar

®

e————0 main editor

figs.

the Tonal editor



The $tatus bar contains 3 elements:

e TrAaCkK Counr of the disc

* Disc 1p displayed as 16 hexadecimal characters STATUS BAR Q,T
e EpIToRr STATUS, showing one of the 4 different §tatuses:
e ! SIDEBAR

track count disc id editor status
7 TRACKS DISC 0C28D20FOA98C155 o ) @ ] v < T ton.
@ [EMPTY] - the document is untouched o e 7 TRACKS DISC 0C28D20FC
@ MODIFIED - - --. the document is modified but unsaved
®SAVING - the document is being saved Livelat Car
o 5 e savinG C
@SAVED - the document is saved with sync status Mikhail Ple
Classical M
. RELEASE #1
g 6. screenshots of the §tatus bar in different Statuses (4] SEEDRN QA LA EE N ISR (5 S OURS ARITWORKE

Johann Seba

14327 +revreernnnncnnanns O" ) Chaconn
The sidebar provides visual guides to the main editor.

Ludwig van

*  Release separator(s) are automatically aligned with the last line of each release block. PianolSanat
*  Lengths of tracks in Mm:ss format are aligned with release and track information in the 09354 evvveneesinnnne O2 SIS,
main editor automatically. 16137 crorersrnnnesanians Ole,  amin,

a When the browser has a constrained width, sidebar is hidden to leave more room for the main editor. Frederic Ch

10303 ccccrrrrrennenenns 04. SCheI"ZC
f1g 7. screenshot of the sidebar 10832 oreeeeeeeeieens 05. Scherzc
07:49 coererrerrencancans 06. Scher\zc

10:38 ................... 07. Scher\zc



ain editor is the only zone that takes user input. You can type, select,
cut Command(38)-X, copy Command(38)-C, and paé’ce Command(38)-V

text in the main editor just like using a plain-text editor.

Although the editor applies some basic $tyles to the text automatically to
make the document easier to scan, there is no need (and no way) to apply Styles

manually. Only plain text is parsed, checked, and persisted.

“ The editor has limited undo/redo support at the moment.

DISC 0C28D20F0A98C155

Live at Carnegie Hall

Mikhail Pletnev

Classical | Deutsche Grammophon | 2001-02 | 1 / 2
ARTWORK

Johann Sebastian Bach - Ferruccio Busoni
01. Chaconne in D minor, BWV 1004

Ludwig van Beethoven

Piano Sonata No. 32 in C minor, Op. 111
02. I. Maestoso
03, II. Arietta

Frédéric Chopin

04. Scherzo No. 1 B minor, Op. 20

05. Scherzo No. 2 in B flat minor, Op. 31
06. Scherzo No. 3 &

O07. Scherzo No. 4 in E, Op. 54

in

in sharp minor, Op. 39

Mikhail Pletnev, piano

rec. 2000-11 in Carnegie Hall, New York City, Live Recording

2.
THE EDITOR
MAIN EDITOR

3.
DOCUMENT
STRUCTURE

A Disc METaDATA DOCUMENT contains:

® 1 or more release blocks

® 1 tracks block with 1 or more tracks

This structure reflects the exact nature that a
disc has 1 or more tracks and belongs to 1 or more
releases (original & reissues). The sidebar helps to

reveal the document stru¢ture automatically.

fig 8. screenshot of the main editor



release block describes a single release that the disc
belongs to. A release block contains 4 content lines and

I ending separator of 3 hyphens.

The first 2 lines are RELEASE T1TLE and RELEASE ARTIST(S)
respectively. These lines are emphasized in bold. The 34 line

consists 4 segments separated by vertical bars (|):

(GENRE
LABEL
RELEASE DATE

Disc Numser and Disc CounT separated by a slash (/).

The 4t line contains an artwork anchor link labeled ARTWORK to

browse and replace artwork.

Some release properties are optional. To represent a missing value,

use the proper placeholder:

Property Placeholder for missing values
® (FENRE receceeeecenes GENRE N/A
@ JLABEL cecececececeenns LABEL N/A
e RELEASE DATE .- RELEASE DATE N/A
e Disc Count - ?
® ARTWORK :-eeeeees ARTWORK N/A

Always do your own research and provide release information as

complete as you can.

Live at Carnegie Hall

Mikhail Pletnev

Classical | Deutsche Grammophon | 2001-02 | 1 / 2
ARTWORK

example of a release block

B You can include multiple genres (separated by commas). You can also

add sub—genres (using [space][greater than sign][space]l):
e J-Pop, Anime Song
e Ambient, Classical > Chamber

B You can include series (after a greater-than sign) and catalog number

(after a hash sign), like:
® Deutsche Grammophon > Originals
® ECM Records > ECM New Series #ECM1405

B When a release has only 1 disc, both the disc number and the disc

count should be omitted: there is no need to write 1 / 1.

o Skip this ?Wt,
eading ths
sttLMNC

‘fCCL {Y@ﬂ t
whew Yo avey
manwal for the fir

Release Title

Release Artist(s)

GENRE N/A | LABEL N/A | RELEASE DATE N/A | 2 / ?
ARTWORK N/A

example of a release block with all optional properties left empty

RELEASE BLOCK



rowsing or uploading the artwork starts from clicking the ARTWORK or ARTWORK 4
N/A anchor link in a release block to open the artwork viewer. Click the “Submit a ’
Better Artwork” button to submit a better artwork. Instructions are provided. RELEASE BLOCK

ARTWORK
VIEWER

The bottom-right of the artwork viewer shows the metadata of the artwork for you to

inspect. To close the artwork viewer, click the “Close” button or press the ESCAPE key.

Newly selected artwork is not finally saved when the artwork viewer is closed. The only way
to save the artwork is by saving the whole disc metadata document by pressing
Command(38)-S when the artwork view is closed.

pletnev Ve

bach-busoni - beethove

Selected image file will be
transcoded to JPEG format (in the
browser) before uploading. Filename
and metadata will NOT be submitted.
Transcoded file size may differ
from your local one.

SIZING GUIDE ]

2560px Excellent (Digital Era)
1400px Good (Physical Era)
600px Average

600px Below Average

Do NOT forget to save the document
(by pressing CMD+S) in order to
truly persist the artwork. Artworks
will be pushed to Tonal apps in
real time. Use your discretion.

# 7C1632F252870A6E
UPLOADED 18 hours ago
FILE SIZE 986KB
WIDTH 1,200px

HETGHT RESSC  f19 9. screenshot of the

IS SQUARE YES
artwork viewer




release has no explicit identifier. To insert discs into
slots of the same multi-disc release, release blocks of

these discs must share the same zdentifying properties.
There are 3 zdentifying properties for multi-disc releases:

®  RELEASE TITLE there are 4 Loentifying properties

° RELEASE ARTI ST(S) fDV SLV\/@ le-disc releases —

the tra t ts also tncluwded
¢ Disc Count he track coun o tncluode

The implications are:

*  When you modify any of the zdentifying properties —
RELEASE T1TLE, RELEASE ARTIST(S), or Disc CounT — of a
release, other discs of the same release need to be

synchronized manually.

*  When you modify only the non-identifying properties —
GENRE, LABEL, RELEASE DATE, or ARTWORK — of any disc
in a multi-disc release, other discs of the same release are

synchronized automatically.

Use multiple release blocks when the disc belongs to multiple

releases (e.g., reissued in a box set).

The order of release blocks is insignificant and will be

automatically re-sorted (by disc count) once saved.

_/

Release Title @

Release Artist(s) @

Genre | Label | Release Date | 1 / 2 ©
ARTWORK

————

identifying properties of a multi-disc release

Original Release Title
Release Artist(s)

Genre | Label | Release Date
ARTWORK

Reissued Release Title

Release Artist(s)

Genre | Label | Release Date | 3 / 10
ARTWORK

P ——

a disc belonging to a single-disc release and a boxset release

MULTI-DISC RELEASE
¢&” REISSUES



TRACKS BLOCK



After the last release block in the document, comes the tracks

block. It’s easier to learn the syntax of the tracks block by examples.

Here is a dummy EP of 4 tracks. This block has 4 track lines.
Each track line §tarts with the track number, a dot ( . ) with a
space, then followed by the title of the track. This is a valid tracks

block in its simplest form.

When all tracks share the same crediting arti$t(s), list them after
the last track with 1 more level of indentation. Each artist line

contains only 1 artist.

™ RuULE I: Artist lines are always indented 1 level deeper than

its nearest preceding track.

This block has 4 tracks. Tracks 1—3 are performed by Alice and
Bob. Track 4 is performed by Alice.

@™ RuULE 2: Artist lines apply to all preceding tracks until

another artist line appears.

Rule 2 can be rephrased as: when a track has no artist line that
follows it immediately, the track shares the same crediting

arti$t(s) as the next track.

Feel free to skip the next page on diff modifiers when reading this

manual for the fir§t time — they are just syntactic sugar!

T

01. Magical Paradise
02. Wait For Flame

03. Gypsy Forest

04. Summer Swing

tracks block in its simplest form

Tonal editor formats track numbers using 2 digits automatically. Feel

free to omit the leading 0 when typing.

01. Magical Paradise
02. Wait For Flame

03. Gypsy Forest
04. Summer Swing
Alice

Bob

all tracks sharing the same crediting artist(s)

B 1 level of indentation = 2 spaces. Tonal editor renders indenting
spaces as semi-transparent white dots to reveal the indentation

level.

01. Magical Paradise
02. Wait For Flame

03. Gypsy Forest
Alice

Bob

04. Summer Swing

Alice

different crediting artist(s) applied to different tracks



01. Magical Paradise

02. Wait For Flame
Alice

03. Gypsy Forest
Alice
Bob

04. Summer Swing

Alice

According to RULE 2, tracks 1, 2, and 4 are
performed by Alice (alone) while track 3 is
performed by Alice and Bob.

This may be simplify using a plus ( +) diff
modifier. Because Bob is only involved in
track 3, list Bob using a plus ( +) diff

modifier after track 3.

01. Magical Paradise
02. Wait For Flame
03. Gypsy Forest

+ Bob
04. Summer Swing

Alice

DIFF MODIFIERS

01. Magical Paradise

02. Wait For Flame
Alice
Bob

03. Gypsy Forest
Alice

04. Summer Swing
Alice
Bob

= e ———

According to RULE 2, we know that Alice
and Bob performed tracks 1, 2, and 4 while

Alice (alone) performed track 3.

This block may be simplify using a minus
( - ) diff modifier. Because Bob is not
involved in track 3, we can list Bob with a

minus ( - ) diff modifier after track 3.

01. Magical Paradise
02. Wait For Flame
03. Gypsy Forest
- Bob
04. Summer Swing
Alice
Bob

01. Magical Paradise
02. Wait For Flame
Alice
Bob
03. Gypsy Forest
Alice
Charlie
04. Summer Swing
Alice
Bob

According to RULE 2, Alice and Bob
performed track 1, 2, and 4 while Alice and

Charlie performed track 3.

Replace Bob with Charlie using the plus
(+) and minus ( - ) diff modifiers together.

01. Magical Paradise
02. Wait For Flame
03. Gypsy Forest
- Bob
+ Charlie
04. Summer Swing
Alice

Bob

B Artist(s) are added to the position of removed artist(s) (or the end when no artist is removed). Do not use diff modifiers when this is not what you need.



The last page of this chapter covers 3

miscellaneous but common topics.

01. Magical Paradise

02. Wait For Flame

03. Gypsy Forest

04. Summer Swing
Alice, vocal, guitar

Bob, bass

I. INSTRUMENTS OR ROLES

Instrument(s) or role(s) an artist plays
are listed in the same line following
the name of the artist, separated by

commal(s).

01. Magical Paradise

02. wWait For Flame
Monochrome Canon
* Alice, vocal, guitar
* Bob, bass

* Charlie, drum

2. GROUPS AND M EMBERS

A §tar ( * ) modifier indicates the
artist on the right-side is a member of

a group listed preceding the artist line.

When Alice, Bob, and Charlie decide
to release the Ep under the trio named

“Monochrome Canon”, revise the tracks

block to refle¢t the fact.

01. Applause
ARTIST N/A

02. Magical Paradise
03. Wait For Flame

Alice

3. PLACEHOLDER ARTIST

Because of RULES 2, sometimes we
need to cut the connections explicitly
when crediting artists are not

applicable.

Without the ARTIST N/A
placeholder, track 1 Applause is also

performed by Alice.

% Congrats! You've learned how to edit tracks and crediting artists.

In the next chapter, let’s focus on classical music. Crediting artists are ignored sometimes

for brevity. When in doubt, revisit RULE 1 and RULE 2 as they always apply.



0.
TRACKS BLOCK
FOR
CLASSICAL MUSIC

Composers * Works ¢ Movements ¢ Sections ° Recording Information



6.1 COMPOSERS AND WORKS A stand-alone work /ine without a track Below are more examples:

number or leading space represents a

Place a composer line before the track(s) multi-movement work of the nearest

George Gershwin

he/she composed with no leading space. preceding composer . Grand Canyon Suite

01. I. Sunrise

02. II. The Painted Desert

™ RULE 3: A composer line applies to all Tracks for individual movements are

the following tracks until another indented at level 1 using 2 spaces.

Paul Dukas

composer line appears.

George Gershwin

01. Rhapsody in Blue

02. An American in Paris

Paul Dukas

03. The Sorcerer’s Apprentice

Do not include composers’ birth and
death years. Such information may be
obtained programmatically. Keep the

document minimal to be future-proof.

George Gershwin (1898 - 1937)
01. Rhapsody in Blue
02. An American in Paris °

Paul Dukas (1865 - 1935)

03. The Sorcerer’s Apprentice

George Gershwin

Grand Canyon Suite
01. I. Sunrise
02. TII. The Painted Desert
03. III. On the Trail
New York Philharmonic

Leonard Bernstein, conductor

a Composer and work lines are

emphasized in bold automatically. Note
the different semantics although they
look the same.

B Dots after Roman numerals are aligned

automatically on save.

a Note that artist lines are indented at

level 2 because the preceding track line
is indented at level 1.

@™ RULE 4: A work line applies to all

the following tracks until another
composer line, work line, or track line

at level 0 breaks the chain.

03. The Sorcerer's Apprentice

a multi-movement work and a single-
movement work of different composers.

George Gershwin
Grand Canyon Suite
01. I. Sunrise
02. II. The Painted Desert

Concerto in F
03. Allegro
04. Adagio

two multi-movement works of the same
composer.

George Gershwin
Grand Canyon Suite
01. I. Sunrise
02. II. The Painted Desert

03. Rhapsody in Blue

a multi-movement work and a single-
movement work of the same composer.



6.2 RECORDING INFORMATION

Use a $tand-alone recording line to specify
recording information (venues and/or

dates) for classical and jazz tracks.

A recording line Starts with the rec.

keyword (with a dot).

™™ RULE 6: A recording line is always
indented 1 level deeper than its

nearest preceding track line.

This is the twin rule of rule 1.

@™  RULE 7: A recording line applies to
all its preceding tracks until

another recording line appears.

This is the twin rule of rule 2.

George Gershwin

01. Rhapsody in Blue

02. An American in Paris
rec. 1959-06-23 in N.Y.

Sergei Prokofiev

Romeo and Juliet
03. Introduction
04. Romeo

rec. 2018

The middle and right columns on the page
discuss 2 less-used features. Feel free to skip
when you are reading this manual for the first
time.

6.4 PLACEHOLDERS

6.3 SecTioNs OF TRACKS N

A classical work may consist of several
sections in the form of parts, books, acts,
scenes, etc. A section line may be placed
before its applying tracks (at the same
indentation level 1) to group tracks into

sections.

™ RULE §: A section line applies to all
the following tracks until another
section line, work line, track line at
level 0, or composer line breaks the

chain.

Sergei Prokofiev
Romeo and Juliet
Act 1
01. Introduction

02. Romeo

Act 2
03. Folk Dance

Sometimes we need to cut the
inheritance chains explicitly when the
composer, section, or recording information
of tracks is either unavailable, unknown,

or non-applicable using placebolders.

Composer A
01. Track 01

COMPOSER N/A
02. Track 02

without the COMPOSER N/A placeholder, track
2 is also composed by Composer A.

Some Composer

Some Work
Section 1
01. Track 01
SECTION N/A
02. Track 02

without the SECTION N/A placeholder, track
2 is also part of Section 1.

01. Track 01
rec. N/A

02. Track 02
rec. 2046 in Hong Kong

without the rec. N/A placeholder, track 1
was also recorded 2046 in Hong Kong.



7. D1sCc REDIRECTION

a This is an intermediate topic that you can safely skip when you
are reading this manual for the first time.

A pisc 1D is generated from the length of tracks (measured in
units of 1/75th seconds) by default. This is called “Toc 1D 4s

DISC ID”.

Multiple audio files with different audio data may be indexed
by the same disc metadata document as long as they share the

same TOC ID.

It is also possible to switch to “aAupro 1D AS D1sc 1D”. This is an
advanced feature not published in the initial version of this
ERIELR

There are discs with slightly different Toc 1Ds but §till share
the same music metadata (e.g., the CD and SACD layers of a
hybrid SACD) — they are the same discs in terms of music
metadata. Do not duplicate music metadata across disc

metadata documents as TONAL DATABASE is duplication free.

Use the redirection command to redireét a disc metadata

document to another with the compatible length of tracks.

A redirected disc metadata document has only one line
containing a redirect sign ( > ) and a TARGET DISC 1D joined by

a whitespace:

> 0c28d20f0a98c155




ErRrROR CHECKING

Error checks are performed to ensure
data quality. Some checks are performed
in the TonAL EprTor while others are

performed in the cloud.
EpI1TOR-S1DE ERROR CHECKING

When the editor finds common

syntactic or semantic errors:

° Red dot(s) are shown in front of
the erroneous lines. Hover on to

reveal more information.

J The editor won’t save the
document when pressing
Command(38)-S

Editor-side errors may be listed here

in the next updates.
SERVER-SIDE ERROR CHECKING
Even though the editor reports no

error, server-side errors may still be

thrown when saving a document:

eoce [Mv (< T tonal & & ©@ h + O
7 TRACKS DISC 0C28D20FOA98C155 MODIFIED
Johann Sebastian Bach - Ferruccio Busoni
14329 crcreneiiiienenns 01. Chaconne in D minor, BWV 1004
Ludwig van Beethoven
* Piano Sonata No. 32 in C minor, Op. 111
09:54 ................... 02. I. Maestoso
6237 errrererenieaiaies 03. 9230 - Ar\ietta
Frédéric Chopin
GGE LY R 04. Scherzo No. 1 in B minor, Op. 20
10332 vrer i, 05. Scherzo No. 2 in B flat minor, Op. 31
07149 i-veesiiiaiaieiiie 06. Scherzo No. 3 in C sharp minor, Op. 39
10338 ccecreeerensenianes 07. Scherzo No. 4 in E, Op. 54
error indicator Quiz:

Can you point out the reason for the error?

TonNaL SErvICES perform more checks with the knowledge of the whole dataset.

These checks may raise EXPECTED SERVER-SIDE ERRORS which may be listed here

in the next updates.

UNEXPECTED SERVER-SIDE ERRORS may be thrown when syncing the document

to various mediums or due to programming errors. Some UNEXPECTED SERVER-

SIDE ERRORS may be resolved by re-saving the document in a few hours. Feel free

to CONTACT US when the error §till exists.



mailto:support@ton.al

STYLE GUIDE

By using ToNAL, you:

Become a member of the ToNAL METADATA
CONTRIBUTORS community:

Agree to follow the latest styling guide established
by the community when making contributions.
Accept the fact that the metadata of your library

may be improved by other contributors.

The initial version of this document focuses on the
syntax and semantics of the ToNAL D1sc METADATA
LANGUAGE. These WIKIPEDIAs §tyle guides may serve as

general §tyle references for the launch moment:

Manual of Style/Music
WikiProjet Classical music/GGuidelines

More conventions may be listed here in the next
updates. Before a dedicated online space exists for

contributors, OPEN AN 1SSUE when in doubt.

SAVE YOUR EDITS

Press Command(88)-S to save your modified document.

Your contributions are also refle¢ted in the ToNAL Disc

CATALOG.

a When the artwork viewer is open, you need to close it by
clicking the “Close” button or pressing the Esc (Escape) key
before saving the document.

Your edits are expected to be pushed to users of the
TonNaL App who colleted the disc in real time. Save the
final version rather than incremental drafts: GiTHuB and
CroupKiT have both (short-term) rate limits and (long-

term) quotas.

If your edits are not synchronized to your ToNaL
Aprp, here is a checklist:

Ensure the save is successful with a green dot after
the app label in the $tatus bar.

Check your network condition. Your 1sp or VPN may
block certain ports used by ApPLE PusH NETWORK.
Ensure that you've enabled iCloud in SysTEm

SETTINGS.

Relaunch the ToNaL App to refresh manually if the
problem still exists.


https://github.com/ICMD/tonal-disc-catalog-en
https://github.com/ICMD/tonal-disc-catalog-en
https://en.wikipedia.org/wiki/Wikipedia:Manual_of_Style/Music
https://en.wikipedia.org/wiki/Wikipedia:WikiProject_Classical_music/Guidelines
https://github.com/ICMD/tonal-disc-catalog-en/issues/new

Thank you

v

for your
contribution!




11. DATA LICENSING

TonaL Disc CataLOG by ToNAL METADATA CONTRIBUTORS
is licensed under CC BY-NC-ND 4.0. Please email

SUPPORT@TON.AL for other licensing-related inquiries.

This license requires that reusers give credit to the creator. It allows
reusers to copy and distribute the material in any medium or
format in unadapted form and for noncommercial purposes only.

The following contents are copyrighted and unlicensed:

° TonaL Disc METADATA in other formats or mediums
*  Source code to process metadata

o Other to-be-announced ToNAL DATABASES

12. CopE OF CONDUCT

ToNAL adheres to CoONTRIBUTOR COVENANT'S CODE OF

Conbuct. In any forum or discussion group, every
community member must follow the rules and values

expressed there. Please email SUPPORT@TON.AL to report any

instance of misconduct.

13. PrRivacy PoLicy

As alocal app, the ToNaL ArP does not require your personal
information to function. The local app is enhanced by the
online ToNAL EDITOR and only exchanges the minimum

required information with it.

Here is all the data that the ToNnaL Aprp and the ToNAL

Epi1Tor colle¢t from you:

e The TonaL App relies on audio metadata (such as the
lengths of tracks) and music metadata (such as titles of
tracks) from your audio files to generate (the initial

version of) a ToNAL Disc METADATA DOCUMENT.

* The ToNaL EDITOR associates your edits with your “Sign

in with Apple” account for auditing purposes.

14. LICENSE AGREEMENT

The ToNAL APP is subject to APPLE’S STANDARD END USER

LICENSE AGREEMENT (EULA).



https://www.apple.com/legal/internet-services/itunes/dev/stdeula/
https://www.apple.com/legal/internet-services/itunes/dev/stdeula/
https://github.com/ICMD/tonal-disc-catalog-en
https://github.com/ICMD/tonal-disc-catalog-en/blob/main/LICENSE.md
mailto:support@ton.al
https://github.com/ICMD/tonal-disc-catalog-en/blob/main/CODE_OF_CONDUCT.md
https://github.com/ICMD/tonal-disc-catalog-en/blob/main/CODE_OF_CONDUCT.md
mailto:support@ton.al
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